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Setting up the app
Step 1 Install Cricut Design Space™ for iPad® from the App Store.

Step 2 The first time you run Cricut Design Space™ for iPad®, you will be guided through the App 
Overview to help you set up and use the app.

Step 3 If you dismiss any of the screens would like to revisit the overview, you can return to it by 
selecting “Machine Setup & App Overview” in the Account menu.

Tip: To use the Cricut Design Space™ app for iPad®, you must have Bluetooth® on your Cricut® machine. 
Cricut Explore Air™ machines have built-in Bluetooth®; to use the app with other machines, you’ll need 
to add the Cricut® Bluetooth® adapter. 
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Firmware is essential for your Cricut Explore® machine to operate properly and communicate 
with your computer. On occasion, firmware updates may be required to enable new functionality 
and improve performance. 

If you receive a firmware update notification, you should go to Cricut Design Space™ on your 
PC or Mac and follow the instructions in the Cricut Explore® User Manual, under 
Machine Setup > Firmware Update. Follow this link:
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Firmware update

http://content.provocraft.com/b/pdfs/explore_manual/firmwareupdate.pdf
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You only need one account with Cricut. Your Cricut ID is the email address you use to sign in to:

 • design in Cricut Design Space™ for PC, Mac®, or iPad®,
 • design in Cricut Craft Room®,
 • shop on Cricut.com,
 • register products,
 • post on Cricut® message boards, or
 • share projects on Project Center.

If you’ve ever done any of these things, you’ve already created a Cricut ID. If you’ve forgotten or lost 
your password, you’ll find a link on the sign in page to help you retrieve it.

If this is your first time signing in, you’ll be creating a Cricut ID. Enter your email address and choose 
a password. To use Design Space® on your iPad®, you’ll need to provide your first and last name and 
specify the country you live in. Since any purchases you make on your iPad® are handled through your 
Apple ID, you don’t need to specify your billing address or credit card  number to make purchases 
with the Cricut Design Space™ app.

Cricut ID

Creating a Cricut ID
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Cricut ID
Signing in with your Cricut ID
Step 1 Open the Cricut Design Space™ app.

Step 2 Tap the Account menu and tap “Sign In” with your Cricut ID. 

Step 3  When you’re signed in, the Account menu icon will display a checkmark in it.
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If you’d like to update your account information, you can do so online.

Step 1 Go to www.cricut.com and sign in with your Cricut ID.

Step 2 Your first name will appear to indicate you are signed in. Click your name to view your 
account info. 

Managing your Cricut ID account
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Cricut ID
Step 3 Use the navigation bar on the left to view the information associated with your Cricut ID. 
Each section has links that allow you to update your info.
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Inserting images
The Cricut Design Space™ for iPad® image library contains over 50,000 images, with more being added 
all the time. You don’t need to own an image to try it out—Design Space® lets you design with an image 
before you buy so you can make sure it will work on your project. 

Tip: Available images may vary by region based on your residential address and the 
licensing agreements.

Step 1 Tap “Start a new project from scratch” or the Design tab to go to the design canvas.

Step 2 Tap the Image button to open the Insert Image panel.
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Step 3 The Insert Image panel lets you view and search for images in the Cricut® Image Library. Drag 
your finger up or down to scroll through the image tiles.

Tip: For more information about an image, tap the information button at the bottom of the image tile. 
The name of the image and the image number are displayed. Tap “View image set” to display all the 
images in the cartridge.

Section 02A
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Inserting images

Tip: See also “Searching for images with categories and filters” in the “Image library” section of 
this manual.



Step 4 Select one or more images and add them to the design screen. Tap on each image you would like 
to use. A checkmark will appear in the top right corner of the tile to indicate you’ve selected it, and a 
thumbnail of the image will appear in the image tray near the bottom of the Insert Image panel.

Tip: Image tiles can be displayed in two di�erent sizes to allow you to view more images at a time or to 
view more detail. Pinch anywhere in the image tile area to zoom in or out.
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Tip: Swipe right or left in the image tray at the bottom of the panel to scroll through all selected images. 
If you wish to remove an image from the tray, tap once on the image thumbnail in the panel or tap twice 
on the thumbnail in the image tray. 

Step 5 Tap “Insert” to add all the images in the tray onto the design screen, or tap “Cancel” to return to 
the design screen without inserting any images.
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There are several ways to search for images:

 • Enter search terms into the search bar
 • Find the digital cartridge (image set) a single image belongs to
 • Search for a digital cartridge by name
 • Browse categories of images
 • Use filters to find your images, di�erent types of images, and multi- or 
  single-layered images

We’ll cover each of these here.

Step 1 To search for images, type a search term in the search bar and tap “Search” on the keyboard. If 
you enter multiple terms, the search function searches for each term separately, providing more images 
to view. For example, typing “red heart” (without quotations) returns all images tagged with either 
“red” or “heart” or both. 

Tip:  Tapping the X at the right side of the search bar will clear the search bar and reset the images view. 
Any applied browse category choices, filter choices, and digital cartridge choices will still apply and are 
not reset by clearing the search bar.

Step 2 Once you have chosen one or more images, tap “Insert” to send them to the design screen. 
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Searching with categories and filters

Using terms in the search bar
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Searching with categories and filters

Step 1 Search for specific cartridges by name by tapping the “Cartridges” drop-down menu.

Step 2  Scroll the list in the drop-down menu or type a search term in the search bar at the top of the 
list. As you type, the search bar displays matching words in the digital cartridge names to narrow your 
search results. The price of each digital cartridge is visible for later purchase.

Searching for digital cartridges
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Searching with categories and filters
Step 3 To select a digital cartridge (a set of images), tap its name in the list. The cartridge images will 
appear in the main screen. A filter tag will appear above the image thumbnails.

Tip: All filter and category tags appear in a horizontally scrollable list above the image thumbnails. If 
you wish to clear a filter or category tag, just tap the X next to the tag, or to clear all of them, tap “Reset 
All” on the right side of the list. 

Step 4 Once you have chosen one or more images, tap “Insert” to send them to the design screen. 
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Searching with categories and filters

Step 1 Start browsing image categories by tapping the “Categories” menu in the top left corner of the 
Insert Image panel. 

Step 2 Select as many categories and subcategories as you’d like. Each category you select will add to 
the number of images you can choose. As you add a category, its tag appears above the image tiles area.

Tip: All filter and category tags appear in a horizontally scrollable list above the image thumbnails. If 
you wish to clear a filter or category tag, just tap the X next to the tag, To clear all of them, tap 
“Reset All” on the right side of the list. 

Step 3 Once you have chosen one or more images, tap “Insert” to send them to the design screen.

Browsing categories



Section 02B Page 5

Section 02B
Image Library

Searching with categories and filters

Step 1 Open the Filters menu by tapping on the filter funnel icon in the top right corner of the Insert 
Image panel next to the search bar. 

Step 2 Select one filter from each filter category (Layers, Type, or Ownership). Each filter you select 
will narrow the number of images you can choose. As you add a filter, its tag appears above the image 
tile area.

Tip: All filter and category tags appear in a horizontally scrollable list above the image thumbnails. If 
you wish to clear a filter or category tag, just tap the X next to the tag, To clear all of them, tap “Reset 
All” on the right side of the list. 

Step 3 Once you have chosen one or more images, tap “Insert” to send them to the design screen.

Using filters
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Using your own images

The Cut What You Want® tool in Cricut Design Space™ for PC and Mac® allows you to upload and use 
your own images for free. While you cannot use the app to upload images, once they’ve been uploaded 
they’re linked to your Cricut ID and are available on the iPad® app as well as your computer. Use your 
PC or Mac® to upload any of the following image types:

 • .jpg
 • .bmp
 • .png
 • .gif
 • .svg
 • .dxf

The Cut What You Want® tool converts your images into shapes you can cut, draw, or print in Cricut 
Design Space™. For more information on how to upload images, see the “Using your own images” 
section of the manual for Design Space® for PC and Mac®.

Once you’ve uploaded images to Cricut Design Space™ using your PC or Mac®, you can design with them 
on your computer or your iPad®.

Step 1 Tap the Image button to open the Insert Image panel.

Uploading your own images

Designing with your own images
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Using your own images
Step 2 Tap to open the Filters menu and select “Uploaded.”

Step 3 Images you’ve uploaded are now shown in the image tile area. Select one or more by tapping the 
image tile to add it to your tray. When you have finished selecting images, tap the Insert Image button to 
add the images to your project.

Tip: Designs created in Cricut Design Space™ app for iPad®—including designs using your own 
images—can be cut, drawn, or scored. While you can use the app to design projects that use the Print 
then Cut feature, you’ll need to use Cricut Design Space™ for PC and Mac® to print then cut them.
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Gestures
Images inserted on the iPad® design screen respond to standard finger gestures to help manage them 
more naturally. There are gestures for:

• selecting a visible image (tap, swipe)
• selecting an image that’s behind another image or partially covered by another
         image (tap, touch and hold)
• selecting multiple visible images (swipe, touch and hold then tap)
• selecting multiple images that are behind another image or partially covered by
         another image (tap, touch and hold)
• moving  selected image (drag)
• panning or scrolling the design canvas (two-fingered swipe)
• zooming in to or out of the canvas (pinch)
• zooming in to or out of the canvas show all images in the project (double tap)
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Make It Now™ projects

Step 1  Open the Cricut Design Space™ app to the Design tab.

Step 2 Tap the Account menu and sign in with your Cricut ID. When you’re signed in, the Account 
menu icon will display a checkmark in it.

Cricut Design Space™ for iPad® features ready-to-make projects created by professional artists. 
These Make It Now™ projects include everything from home décor to fashion to paper crafting, and 
even a variety of FREE projects. New projects are added on a regular basis. To make a project, all you 
need to do is gather your supplies and go. 
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Step 3 Scroll through all Make It Now™ projects available in the Projects tab or tap the Projects 
menu to select a project category.

Step 4 Select a project by tapping the project tile.

Make It Now™ projects

Section 04A
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Make It Now™ projects
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Step 5 The project preview pane lists project details and operations that can be performed.

 • Project Name
 • Di�culty Level
 • Estimated Completion Time
 • Price: The project price is discounted by the price of images you own or are subscribed to.
 • Preview: Shows the completed project. May contain more than one photo; swipe or tap gray 
  circles below photo to view.
 • Project Resources: Thumbnails of the images included in your project. Scroll down to view all.
 • Customize: Opens the project on the design screen so you can make changes to the project.
 • Make It Now: Opens the project in the mat preview so you can make the project without 
  any changes.

Section 04A
Projects



Make It Now™ projects
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Step 6 Make It Now™ projects often have more than one photo. If there are multiple photos, small 
gray circles will appear below the main photo. Tap on the circles to see alternate views of the project.

Step 7 Next to the picture you will find images that are needed to complete this project. Below each 
image you’ll see if you own the image, if it’s available in a subscription, if it’s free, or if it’s available 
for purchase.

Tip: Sometimes Make It Now™ projects don’t use all the layers of a multi-layered image. When you 
purchase the project, all layers of the image are included in your purchase and are available to 
you for future projects.

Section 04A
Projects
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Make It Now™ projects
Step 8 There are two options to choose when you are working with Make It Now™ projects. Tap 
“Make It Now” if you would like to make the project exactly as shown. This will take you directly to 
the mat preview to begin cutting the project mats. Tap “Customize” to adjust the project. This will 
open the project in the design canvas.

Step 9  Once you’re done cutting, return to the Projects tab to view the project preview pane and follow 
the instructions on project assembly.

Tip: If you customize a Make It Now™ project and then save it to your account, the original instructions
 will no longer apply.

Section 04A
Projects
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Starting a new project
There are two ways to begin a new project: from the Projects tab or from the Design tab. We’ll cover 
both here.

Tip:  Be sure to save your project as you go so that it is saved to the cloud for future designing or cutting.
Once it’s saved, you can access the project from your computer or iPad®.

Step 1 Open the Cricut Design Space™ app to the Projects tab.

Step 2 Tap the Account menu and sign in with your Cricut ID. When you’re signed in, the Account 
menu icon will display a checkmark in it.

Step 3 Tap the project tile labeled “Start a new project from scratch.”

Starting from the Projects tab
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Starting a new project

Step 1 Open the Cricut Design Space™ app to the Design tab.

Step 2 Tap the Account menu and sign in with your Cricut ID. When you’re signed in, the Account 
menu icon will display a checkmark in it.

Step 3 Tap the New Project button.

Starting from the Design tab
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Saving projects
Tapping the “Create New Project” tile in the Projects tab and creating a project on the canvas is just the 
first step. As you design your project, save it so that it is available in My Projects on your PC, Mac®, or 
iPad® at a later date.
 
Projects in progress on your iPad® are automatically saved to your iPad®. If you quit the app and return 
to it later, it will be available just as you left it. However, it will not be saved to the cloud unless you tap 
the Save button. If you start a new project, you will be asked whether to save or discard it when you 
start a new project on your iPad®. Once discarded, it can’t be recovered.

Step 1 Open the Cricut Design Space™ app to the Design tab.

Step 2 Tap the Account menu and sign in with your Cricut ID. 

Step 3 When you’re signed in, the Account menu icon will display a checkmark in it.

Section 04C
Projects
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Saving projects
Step 3 Tap the Save Project menu and select “Save.” If you’re updating a saved project, you can select 
“Save” to save changes using the current project name or “Save As” to save your changes with a new 
name in a separate project. 



Step 4 The saved project will appear as a project tile in the Project tab.

Section 04C
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Saving projects
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Opening saved projects

Step 1  Open the Cricut Design Space™ app to the Projects tab.

Step 2 Tap the Account menu and sign in with your Cricut ID. When you’re signed in, the Account 
menu icon will display a checkmark in it.

Cricut Design Space™ is cloud-based, so your projects are accessible from any compatible PC or Mac®, 
or any iPad® with the Cricut Design Space™ app.
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Step 3 Tap the Projects menu and select “My Projects.” 

Step 4 Your saved projects will be displayed. If a project was created using the Cricut Design Space™ 
app, a preview image will be displayed in the project tile. Tap a project tile to continue.

Tip: If you wish to start a new project, tap the Create New Project tile. 

Opening saved projects
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Step 5 The project preview pane lists project details and operations that can be performed.

 • Project Name
 • Date Modified
 • Price: The project price is discounted by the price of images you own or are subscribed to.
 • Preview: Shows the project as laid out on the design screen.
 • Project Resources: Thumbnails of the images included in your project. Scroll down to view all.
 • Duplicate: Duplicates the project and saves it to My Projects. You will be required to give the 
  copied project a new name.
 • Delete: Permanently deletes the project from My Projects. It will not be available on your 
  iPad®, PC, or Mac.
 • Rename: Renames and saves the project without saving it as a new project.
 • Customize: Opens the project on the design screen so you can make changes to the project.
 • Make It Now: Opens the project in the mat preview so you can make the project without 
  any changes.

Step 6 Next to the picture you will find images that are needed to complete this project. Below each 
image you’ll see if you own the image, if it’s available in a subscription, if it’s free, or how much it costs 
to purchase.

Tip:  Double tap on a project tile to open the project in the Design tab directly, bypassing the project 
preview pane.

Tip:  Tapping outside of the project preview pane will dismiss it and return you to “My Projects.”

Section 04D
Projects
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Design screen view

Step 1 Drag two fingers to pan around the design screen.

Step 1  Place your thumb and index finger on the design screen (not touching images).

It’s easy to pan the design canvas to view other parts of it. You can also zoom in or out of the design 
canvas. A third option is to double tap the canvas to bring all the images into view and centered on the 
design canvas. 

Panning the design screen

Zooming the design screen
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Step 2 The pinching gesture changes the magnification of the design screen. Pinching fingers away 
from each other will zoom in to increase magnification of the design screen and all images. Pinching 
fingers towards each other will zoom out to reduce magnification of the design screen and all images.

Tip: The rulers and the background grid change scale as the design screen is zoomed in or out.

Design screen view

Section 05
Design screen view

Step 1 Double tap the design screen (not touching images). The project will zoom in or out to show 
all images in your project and the view of the design screen will be centered.

Centering image view
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Selecting

Step 1  Tap on the image to select it. You’ll know the image is selected when the bounding box appears 
around the edges.

Tip: The image manipulation handles will appear as well. These resize, rotate, delete, and lock/unlock 
the aspect ratio for the image selected. 

Option 1

There are several di�erent ways to select images on the design screen, whether you are selecting a 
single image or multiple images.

Selecting a single image
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Selecting

Section 06A
Working wtih images

Step 1 Tap the Layers button in the bottom bar to open the Layers panel.

Step 2 Select the title of the image in the Layers panel to select the image on the design canvas.

Option 2



Selecting
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Step 1 If an image is partially or completely covering the image you want to select, tap once on the 
image that is covering the image.

Step 2 Tap again where you know or think the other image may be under the top image.

Option 3



Selecting
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Option 1

The quickest way to select multiple images is by swiping to create a selection box.

Step 1 Double tap on an empty area of the design screen. This will zoom in to or out to show all 
the images.

Step 2 Swipe to create a selection box that touches all of the images you want to select. The selection 
box will be shaded in a light blue.

Tip: The selection box is only required to touch the items to be selected. It is not necessary to drag the 
selection box over an entire image unless there are ungrouped items or hidden images/text behind 
an image.

Section 06A
Working with images

Selecting multiple images
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Working with images

Option 2

You can select multiple images one at a time by following the steps below.

Step 1 Tap once on the first image to select it. You’ll know the image is selected when the bounding 
box appears around the edges.
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Selecting

Section 06A
Working with images

Step 2 Touch and hold a second image. You’ll know both are selected when a bounding box appears 
around both images. Repeat with other images as desired.

Tip: A more subtle bounding box will appear around each image that is selected within the larger 
more boldly highlighted bounding box area. This helps identify which items within the bounding box 
are selected.
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Selecting
Option 3

When one image is partially hidden behind another image, you can still select it along with any 
other images you desire. 

Step 1 If an image is partially or completely covering the image you want to select, tap once on the 
image that is covering the image. You’ll know the image is selected when the bounding box appears 
around the edges. 

Step 2 Tap again where you know or think the other image may be located under the first image.
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Selecting
Step 3 If you wish to add more images to the selection, touch and hold a second image. You’ll know both 
are selected when a bounding box appears around both images. Repeat with other images as desired.

Tip: A more subtle bounding box will appear around each image that is selected within the larger 
more boldly highlighted bounding box area. This helps identify which items within the bounding 
box are selected, as in the center image in the screen capture below. 
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Positioning

Step 1  Tap on the image to select it. You’ll know the image is selected when a bounding box appears 
around it. 

Step 2 Place a finger inside the bounding box and drag to change the position of the image. While you 
are dragging the image, a position indicator appears near the image. 

Tip: Smart Guides indicate position alignment of the image relative to other images within its vicinity. 
The guides align the centers, tops, and bottoms of two images and combinations of these. Smart Guides 
can be turned on or o� in the Settings menu.

Tip: Position units are in the same units as the rulers at the edge of the design. The ruler units can be 
switched between inches and centimeters by tapping the Settings menu and turning Metric Units 
on or o�.

There are two ways to change the position of images on the design canvas: by dragging the image or 
entering a new position in the Edit panel. 

Dragging images
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Positioning

Step 1  Tap on the image to select it. You’ll know the image is selected when the bounding box appears 
around the edges. 

Step 2 Tap the Edit button in the bottom menu bar to open the Edit panel.

Step 3 Tap Horizontal Position or Vertical Position in the Edit panel and either enter a new position 
using the keypad or tap the (+) or (–) buttons to change the position of the image.

Tip: Position is always measured from the top left corner of the design area to the top left corner of 
the bounding box.

Tip: Position units are in the same units as the rulers at the edge of the design. The ruler units can be 
switched between inches and centimeters by tapping the Settings menu and turning Metric Units 
on or o�.

Step 4 Tap the Edit button again to dismiss the Edit panel.

Positioning with the Edit panel
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Resizing

Step 1 Tap on the image to select it. You’ll know the image is selected when a bounding box appears 
around it. 

Step 2 Drag the resize handle toward the center of the image to shrink it or away from the center of the 
image to increase its size. While you are dragging the resize handle, a size indicator appears near 
the image. 

Tip: Image size units are in the same units as the rulers at the edge of the design. The ruler units can 
be switched between inches and centimeters by tapping the Settings menu and turning Metric Units 
on or o�.

There are two ways to change the size of images on the design canvas: by dragging the resize handle 
or entering new measurements in the Edit panel.

Drag the resizing handle with the aspect ratio locked or unlocked. When the aspect ratio is locked 
(the default state), the width and height change in proportion to each other. When it is unlocked, you 
can change the width or height independently of each other.

Resizing with the resize handle

untitled
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Resizing
Step 3 If you wish to unlock the aspect ratio, tap the aspect ratio lock. Unlocking the aspect ratio 
allows you to freely resize the image without keeping the width and height in proportion.

Tip: If you do not like the results of your resizing action, the Undo button can safely undo any changes 
you make.
 



Step 1  Tap on the image to select it. You’ll know the image is selected when a bounding box appears 
around it. 

Step 2 Tap the Edit button in the bottom menu bar to open the Edit panel.

Step 3 Tap Image Width or Image Height in the Edit panel and either enter a new size using the keypad 
or tap the (+) or (–) buttons to increase or decrease the size of the image.

Tip: Image size units are in the same units as the rulers at the edge of the design. The ruler units can be 
switched between inches and centimeters by tapping the Settings menu and turning Metric Units 
on or o�.

Specify the image size using the Edit panel with the aspect ratio locked or unlocked. When the aspect 
ratio is locked (the default state), the width and height change in proportion to each other. When it is 
unlocked, you can change the width or height independently of each other.

Resizing with the Edit panel

Section 06C
Working with images
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Resizing



Section 06C
Working with images

Section 06C Page 4

Resizing
Step 4 If you wish to unlock the aspect ratio, tap the aspect ratio lock in the Edit Panel. Unlocking the
 aspect ratio allows you to freely resize the image without keeping the width and height in proportion.

Tip: If you do not like the results of your resizing action, the Undo button can safely undo any changes 
you have made.
 

Tip:  Tapping away from the image deselects it. Tapping the image again will reset the aspect ratio 
to locked.
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Rotating

Step 1 Tap on the image to select it. You’ll know the image is selected when the bounding box appears 
around the edges. 

Step 2 Drag the rotate handle to change the angle of the image. While you are dragging the rotate handle, 
an angle indicator appears near the image.

Tip: Smart guides indicate when the image is rotated in multiples of 45 degrees from the vertical 
position. Smart guides can be turned o� by tapping the Settings menu and turning Smart Guides 
on or o�.

There are two ways to change the rotational angle of images on the design canvas: by dragging the 
rotate handle or entering a new angle in the Edit panel.
 
Tip: Rotation will not be preserved on the cutting mats unless you have attached the image to a layer.

Rotating with the rotate handle
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Rotating
Step 3 Tapping away from the image deselects it.  The bounding box is reset be vertical in the new 
position when it is selected again. The Undo button can safely undo any changes you have made.



Step 1 Tap on the image to select it. You’ll know the image is selected when the bounding box appears 
around the edges.

Step 2 Tap the Edit button in the bottom menu bar to open the Edit panel.

Step 3 Tap Rotate Angle in the Edit panel and enter a new angle using the keypad or tap the (+) or (–) 
buttons to increase or decrease the angle of the image.

Tip: The (+) and (–) buttons in the numeric keypad increase or decrease by 1 degree increments. Using the 
Edit panel allows for more precise control of the rotational angle.

Step 4 Tap the Edit button again to dismiss the Edit panel.

Rotating with the Edit panel
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Rotating



Step 1 Tap on the image to select it. You’ll know the image is selected when the bounding box 
appears around the edges.

Step 2 Tap the Edit button in the bottom menu bar to open the Edit panel.

Step 3 Tap one of the mirror buttons in the Edit panel to flip the image vertically or horizontally. 

There are two ways to mirror images: on the design screen or the mat preview.

Step 4 Tap the Edit button again to dismiss the Edit panel.

Mirroring with the Edit panel
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Mirroring



Step 1 If you plan to cut iron-on, complete your design on the design screen first.

Step 2 Tap Send to Mat.

Mirroring in the mat preview

Section 06E
Working with images

Section 06E Page 2

Mirroring

Step 3 Select “Mirror (for iron-on)” in the mat preview to flip the entire project horizontally.
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Adding

Step 1  Tap the Text button to insert a text box onto the design canvas and open the keyboard and Text 
Edit panel. A text edit field will open near the text box.

The Cricut Design Space™ app makes it easy to personalize your project using text and di�erent fonts. 
You can use fonts from the Cricut® Image Library, the fonts installed on your iPad®, or both.
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Step 2  Type your text in the text edit field and watch as it appears in the text box in the selected font 
and style.

Tips for working with text:  

 • The design canvas can be scrolled or zoomed in/out above the keyboard to show other images 
  or text while you type. This is especially useful to see items hidden below the keyboard.

 • Tapping outside of the field closes the text edit field and dismiss the keyboard and Text Edit 
  panel. Double tapping on the text box opens the Text Edit panel.

 • You can have more than one line of text inside a text box; create line breaks using the enter 
  key on your keyboard. 

 • Text boxes can only contain one font; however, you can add as many text boxes to a project 
  as you desire.

 • Find text layers in the Layers panel by looking for a thumbnail of the first letter of the text.

Adding
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For more information about working with text:

 • Use the Text Edit panel to customize the font, alignment, size, letter, spacing, and more. See 
  the other sections of the “Working with text” section of this manual for more information.

 • The selected text box can be moved, rotated, and resized using any of the gestures, image 
  manipulation handles, or tools in the Edit panel. Text boxes appear as an image group, meaning 
  all letters and layers move and size together.  See the “Working with images” section of this 
  manual for more information.

 • Use the Layers panel to select a line style (cut, draw, score, or print), change the color of the text, 
  group text layers with other layers, arrange the order of layers, duplicate or delete text, and hide 
  or unhide text layers. See the “Layers panel” section of this manual for more information.

 • If you choose to draw (write) the text, the color options will change to match the colors of the 
  available Cricut® pens. Cricut Design Space™ for iPad® will prompt you when to use your pen 
  as you make your project. You must attach the drawing layer to another layer so that it appears 
  on the correct cutting mat. See “Attaching & detaching” in the “Actions panel” section of this
  manual for more information.

Adding
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Text edit panel
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The Text Edit panel in Cricut Design Space™ for iPad® is very similar to the Image Edit panel when it 
comes to sizing, rotating, and positioning text. It also makes finding the right font and editing text 
simple so you can easily personalize your projects. This section of the manual covers:

 • opening the Text Edit panel,
 • selecting a font,
 • selecting a font style,
 • selecting text alignment,
 • altering the space between letters, and
 • altering the space between lines.

For information about changing the width, height, rotation angle, or position of a text box, or about how 
to mirror the text box, see the “Working with images” section of this manual.
 
Cricut® fonts often have more than one layer. You can unhide hidden layers by tapping the Unhide 
button (represented by an eye icon) at the bottom of the Layers panel. For information about hiding and 
unhiding layers, see “Hiding & unhiding” in the “Layers panel” section of this manual.

Step 1  To locate a font style perfect for your project, tap on a text box to select it. You’ll know the image 
is selected when the bounding box appears around the edges.

Step 2 Double tap the text box to open the Text Edit panel and keyboard. Alternatively, you can select 
the text box and tap on the Edit button to open the Text Edit panel. 
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Opening the Text Edit panel
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Text edit panel

Step 1 Tap “Font Name” to open the Font Name menu. There are three tabs so you can switch between 
font viewing options:

 • Cricut: Displays fonts from the Cricut® Image Library 
 • System: Displays fonts found on your iPad®

 • All: Displays all fonts available for use

Each Cricut® font displayed has information listed beneath it. You can see:

 • Writing Style: All fonts have a cutting style, but some also include a version that is meant to be 
  written by the Cricut Explore® machine using a pen. These are indicated by the words 
  “Has Writing Style.”
 • Layers: Fonts from the Cricut® Image Library may have more than one coordinating layer. 
  Fonts with only layer are labeled “Single Layer,” while fonts with more than one layer are 
  labeled “Multi Layer.”
 • Ownership: If you do not own the font, the price will be displayed. If the image is free, if you 
  have purchased the font, or if you have a subscription to the Cricut® Image Library that 
  includes the font, it will be indicated here.

Step 2 Tap a font name to select it. 

Step 3 Tap o� the Font Name menu to dismiss it.
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Text edit panel

Step 1  Tap the Style button to open the Style menu.  

Step 2 Select a style of text. Examples include Bold, Italic, Writing, or any other style associated with 
the font you have selected.

Tip: Not all fonts have di�erent styles associated with them.

Step 3 Tap o� the Style menu to dismiss it.

Selecting a font style
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Text edit panel

Step 1 Tap the Alignment button to open the Alignment menu.  

Step 2 Select a horizontal alignment style for your text: Left, Center, or Right. 

Tip: Text alignment defaults to the left, but you can also choose to center or right-align your text.

Step 3 Tap o� the Alignment menu to dismiss it.

Selecting text alignment
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Text edit panel

Step 1 Tap the Size button to open the Size menu.  

Step 2 Type a number in the field or use the (+) or (-) buttons to change the size of your text. 

Step 3 Tap o� the Size menu to dismiss it.

Selecting text size
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Text edit panel

Step 1 “Letter Space” indicates the distance between letters in a single text box. Tap the Letter Space 
button to open the Letter Space keyboard.

Step 2 Type a number or use the (+) or (-) buttons to bring letters closer together or farther apart.

Step 3 Tap o� the Alignment menu to dismiss it.

Altering the distance between letters
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Text edit panel

Step 1 “Line Space” indicates the distance between lines of text in a single text box. Tap the Line 
Space button to open the Line Space keyboard.

Step 2 Type a number in the field or use the (+) or (-) buttons to bring lines of text closer together or 
farther apart. 

Step 6 Tap o� the Line Space menu to dismiss it.

Altering the space between lines



Section 07C
Working with text

Section 07C Page 1

Ungrouping and isolating letters

Step 1 Tap to select the text box with the layers you want to ungroup. 

Step 2 Tap the Layers and Actions buttons to open the Layers panel and Actions panel. Notice that in 
the figure below, the text box selected is shown in the Layers panel as a single group with two layers. 

When working with layered Cricut® fonts, you have the option to ungroup text in two di�erent ways: 
by ungrouping text layers or isolating letters. Ungrouping text layers allows you to move and resize
each layer of text independently, but keeps the letters grouped together. Isolating letters allows you to 
move and resize each letter independently, but keeps each letter’s layers grouped together.

Ungrouping text layers keeps the letters of the text box grouped together, but separates multiple text 
layers so they can be worked with independently. Changes to a layer will a�ect all the letters in 
that layer.

Ungrouping text layers
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Ungrouping and isolating letters
Step 3 With the text box selected, tap the Ungroup button in the Actions panel. Each text layer is 
separated into its own layer group, as seen in Layers panel in the figure below. The letters in the text 
box remain grouped together, but the layers can now be managed independently: they can be resized, 
moved, hidden, or unhidden, or they can have their color or line type changed. These transformations 
will a�ect all the letters belonging to the selected layer. 
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Ungrouping and isolating letters

Isolating letters keeps the text layers of each layer together, but separates each letter from the others 
in the text box so they can be worked with independently. Changes to a letter will a�ect all the layers 
that make up the letter.

Step 1 Tap to select the text box with the letters you want to isolate. 

Step 2 Tap the Layers and Actions buttons to open the Layers panel and Actions panel. Notice that in 
the figure below, the text box selected is shown in the Layers panel as a single group with three layers. 

Isolating Letters
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Ungrouping and isolating letters
Step 3 With the text box selected, tap the Isolate Letters button in the Actions panel. Each letter is 
separated from the other letters, as seen in Layers panel in the figure below. The layers of each letter 
remain grouped together, but the letters can now be managed independently: they can be resized, 
moved, hidden, or unhidden, or they can have their color or line type changed. These transformations 
will a�ect all the layers belonging to the selected letter.
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Changing line type
Line type determines if your image will be cut, drawn, or scored in your final project. The line type is 
shown next to the layer thumbnail and is represented by one of four line type icons:

Cut: The layer will be cut from your material.

Write: The layer will be drawn with a Cricut Explore® pen.

Score: The layer will be scored (to score is to create a groove to facilitate folding) and will require the 
use of the Cricut® Scoring Stylus.

Tip: Print layers cannot be printed from the app. While projects with print layers can be designed in 
the app, you will need to use Cricut Design Space on your PC or Mac® to complete the project.

Print: The layer will be printed then cut out using the Print then Cut feature of Cricut Design Space™ 
for PC or Mac.
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Step 1 Tap the Layers button to open the Layers panel. The current line type is displayed for each 
layer that is not hidden (hidden layers are indicated with an icon in the shape of an eye with a line 
through it). 

Tip: Individual layers can be changed into printable images by changing their line type; however, 
they will each print separately (see “Changing line type” in the “Layers panel” section of the 
manual for more information). If you want to combine multiple layers into a single printable 
image, use the Flatten tool.

Step 2 To open the Line Type panel, tap the arrow located on the right side of a layer in the 
Layers panel.

Section 08A
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Changing line type
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Step 3 Tap the Cut, Write, Score or Print tab to select the line type. The image in the Design Space™ 
will change to reflect your choice.  Repeat to change line type of other layers if desired.

Tip: Print layers cannot be printed from the app. You will need to use Cricut Design Space on your PC 
or Mac® to complete a project that contains any layers whose line type is set to print. If you wish to 
complete the project without printing, you can change the line type to another option or hide the print 
layer by tapping the eye icon at the bottom of the Layers panel. Hidden layers are not cut, written, 
scored, or printed.

Tip: If your project has multiple layers, any layers that have a write or score line type must to be 
attached to another layer in order to complete the project. See “Attaching & detaching” in the 
“Actions panel” section of the manual for more information.
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Changing fill color
Fill color allows you to change the color of your image so you can better visualize your final project. 
The color is only a representation. The material that is placed on your cutting mat will be the project’s 
final color. Fill colors can be selected for layers with cut or write line types. You can choose from a 
custom color picker for layers that will be cut, or from any of the Cricut Explore® pen colors for layers 
that will be written or drawn. 
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Step 1 Tap the Layers button to open the Layers panel.

Step 2 To change the color of a layer, tap the arrow at the right of the layer in the Layers panel. 
The four tabs (Cut, Write, Score, and Print) indicate the line type for that layer. 
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Changing fill color
Step 3 As color is chosen in the window, the image or text on the design canvas changes to reflect 
your choice.



Tip:  You can also change the color of a layer that will be drawn. Choose from the list of pen colors.
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Duplicating
Duplicating a layer or layer group creates a new copy of the selected layer or layer group. You can 
duplicate one or more images, layer groups, and layers using the Duplicate button at the bottom of the 
Layers panel. You can also duplicate using the Duplicate button in the Actions panel.
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Step 1 Tap the Layers button to open the Layers panel or the Actions button to open the Actions 
panel.

Step 2 Select one or more layers or layer groups to duplicate (see “Selecting” in the “Working with 
images” section of this manual for tips on selecting layers). 

Tip: If you want to duplicate only one layer of a layer group, you must ungroup the layers first (for more 
information, see “Grouping & Ungrouping” in the “Layers panel” section of this manual).
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Step 3 Tap the Duplicate button at the bottom of the Layers panel or in the Actions panel. The 
duplicated layer(s) will appear on the design screen and in the Layers panel. Move the image away from 
its duplicate by dragging the selected image.

Section 08C
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Duplicating
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Hiding & unhiding

Hiding a layer

Many images in the Cricut® Image Library have hidden layers (often shadows) that are present but do 
not immediately appear when added to the design canvas. Hidden layers are indicated in the Layers 
panel with an icon in the shape of an eye with a line through it.  When a layer is hidden, it does not 
appear on your canvas or cut with the final project.
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Step 1 Tap the Layers button to open the Layers panel.

Step 2 Select one or more visible layers or layer groups to hide (see “Selecting” in the “Working 
with images” section of this manual for tips on selecting layers). 

Step 3 Tap the Hide button at the bottom of the Layers panel. The hidden layer(s) will disappear 
from the design canvas and will be indicated in the Layers panel with an icon in the shape of an eye 
with a line through it.
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Section 08D
Layers Panel

Hiding & unhiding
Unhiding a layer
Step 1 Tap the Layers button to open the Layers panel.

Step 2 Select one or more hidden layers or layer groups to unhide (see “Selecting” in the “Working 
with images” section of this manual for tips on selecting layers). 

Step 3 Tap the Unhide button at the bottom of the Layers panel. The unhidden layer(s) will appear 
on the design canvas and will be indicated in the Layers panel with a line type icon.
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Deleting
You can delete one or more images, layer groups, and layers using the Delete button at the bottom of 
the Layers panel or by tapping the Delete button in the upper left corner of the bounding box.

Step 1 Tap the Layers button to open the Layers panel.

Step 2 Select one or more layers or layer groups to delete (see “Selecting” in the “Working with 
images” section of this manual for tips on selecting layers).

Step 3 Tap the Delete button at the bottom of the Layers panel or in the upper left corner of the 
bounding box.  

Step 4  The deleted layer(s) are removed from the design canvas and Layers panel.
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Color Sync panel

Step 1 Tap the Sync button to open the Color Sync panel.

Step 2 Tap and hold a layer handle, then drag the layer on top of another layer and release it. 

Step 3 The color of the first layer will change to the color of the second layer. 

The Color Sync panel allows you to sync up layer colors to reduce the number of di�erent material 
colors you plan to use in this project. Sync layer colors by dragging a layer and dropping it on another 
layer whose color you want to match.



Section 10
Project canvases

Section 10 Page 1

Project canvases
Placing a project canvas on the design canvas allows you to better visualize your final project. The 
project canvas is only a representation. It does not cut; instead it acts as a guide to help you see how 
the finished project will appear. Project canvases can only be selected in Cricut Design Space™ on your 
PC or Mac®. For details, see the “Project canvases” section of the user manuel for Cricut Design Space™

for PC and Mac®.
 
Tip: If you created a project in Cricut Design Space™ for PC or Mac® and inserted a project canvas, the 
project canvas will be visible in Cricut Design Space™ for iPad®; however, you will not be able to alter 
the project canvas.
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Grouping & ungrouping

Tip: When layers are grouped, it is only for convenience when working on the project. Groups will 
not change how the layers appear on the cutting mats.

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the 
Layers panel.

Step 2 Select two or more layers or layer groups (see “Selecting” in the “Working with images” section 
of this manual for tips on selecting layers).

Tip: Entire layer groups can be grouped with other layer groups, but individual layers that are part of a 
layer group must be ungrouped in order to be grouped with other layers.   

Many of the images in the Cricut® Image Library have multiple layers. These layers are grouped 
together when you add them to the design screen, so they move and resize together unless you 
ungroup them.

Grouping layers



Step 3 Tap the Group button in the Actions panel to group the selected layers together.

Step 4 Tap the Actions button again to dismiss the Actions panel.

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the 
Layers panel.

Step 2 Select a layer group by tapping on it on the design screen or by tapping the layer group name in 
the Layers panel. 

Section 11A
Actions Panel

Section 11A Page 2

Grouping & ungrouping

Ungrouping layers



Step 3 Tap the Ungroup button to break up the layer group into individual layers.

• Layer groups move and resize together.

• Each layer of the image group appears in the Layers panel and is highlighted when selected.

• Layer groups can be selected by tapping the layer group name in the Layers panel.

• Whether layers are grouped or ungrouped, the line type (cut, write, score, print) and fill color can be  
 changed one layer at a time in the Layers panel.

• Whether layers are grouped or ungrouped, the line type (cut, write, score, print) can be changed   
 from the Layers panel.

• Whether layers are grouped or ungrouped, layers can be hidden or unhidden by tapping the eye icon  
 at the bottom of the Layers panel.

Step 4 Tap the Actions button again to dismiss the Actions panel.

Tips for working with layer groups
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Attaching & detaching
The Attach tool has two functions. Attach holds your cuts in position so that images on the cutting mat 
will appear exactly as they show up on the design canvas. Attach can also fasten a write or score layer to 
a cut layer. The Detach tool separates attached layers.

Tip: If there is more than one layer in a project, any write or score layers must be attached to another 
layer so that they will be written or scored on the correct mat.

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the Layers panel. 

Step 2 Select the layers or layer groups you would like to cut in a specific position on the mat. They will 
all be cutting from the same mat, so it’s a good idea to attach layers that share a color groups (see 
“Selecting” in the “Working with images” section of this manual for tips on selecting layers).

Tip: You may wish to ungroup layers of a layer group before attaching, as the Attach tool will convert all 
selected layers into a single color that will be cut from the same mat (see “Grouping & ungrouping” in 
the “Actions panel” section of this manual). Once layers have been attached, they can then be grouped 
with other layers without a�ecting the way the project cuts on the mat.
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Using Attach to hold position on the mat 



Step 3 Tap the Attach button to attach the selected layers so that they hold their position on the cutting 
mat as they appear the design canvas. You will know the layers are attached because they appear in the 
Layers panel with the label “Attached Set” (grouped layers that have been attached will appear as 
subsets of the attached set).

Step 4 When you are send the project to the mat, the images appear on the mat preview exactly as you 
have them arranged on your project.
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Attaching & detaching
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Attaching & detaching
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Tip: If items are not attached, the project will cut in paper saver mode, meaning it will automatically 
place objects on the cutting mat as close together as possible to conserve material.

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the 
Layers panel.

Step 2 Select the write or score layer along with a single layer or layer group to which it 
will be attached (see “Selecting” in the “Working with images” section of this manual for 
tips on selecting layers).

Using Attach to fasten a write or score layer to a cut layer 



Tip: You may wish to ungroup layers of a layer group before attaching, as the Attach tool will convert 
all selected layers into a single color that will be cut from the same mat (see “Grouping & ungrouping” 
in the “Actions panel” section of this manual). Once layers have been attached, they can then be 
grouped with other layers without a�ecting the way the project cuts on the mat.

Step 3 Tap Attach to attach the write or score layer to the other layer. You will know the layers are 
attached because they appear in the Layers panel with the label “Attached Set.”

Tip: Text layers that have been attached are converted to images and the text cannot be edited. If you 
wish the edit the text, detach the text layer. Reattach it when you have finished editing the text. 
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Detaching layers

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the 
Layers panel. 

Step 2 Select the attached set from which you want to detach the layers.

Step 3 Tap the Detach button in the Actions panel to split the attached set into individual layers. You 
will know the layers are detached because they appear individually in the Layers panel without the 
label “Attached Set.”
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Welding
The Weld tool joins shapes to create a single customized image, removing any overlapping cut lines. 
This can be a great way to simplify a design, keep the letters of a word connected for easy assembly, or 
combine shapes to create new designs.

Tip: You may wish to ungroup layers of a layer group so that you can arrange them separately. The 
Weld tool will convert all selected layers into a single image (see “Grouping & ungrouping” in the 
“Actions panel” section of this manual). Once layers have been welded, they can then be grouped with 
other layers without a�ecting the way the project cuts on the mat.

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the Layers 
panel. 

Step 2 On the design canvas, position the layers you would like to weld so that they overlap.
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Step 3 Select the layers or layer groups you would like to weld together (see “Selecting” in the 
“Working with images” section of this manual for tips on selecting layers). Once two or more 
layers are selected, the Weld button will become active in the Actions panel.

Step 4 Tap “Weld” in the Actions panel to merge the selected layers together. Wherever cut paths have 
intersected, only the exterior cut path will remain. You will know that your images are welded when 
they change to the same color and a new image labeled “Welded Image” appears in the Layers panel.

Welding
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Tip: To weld letters together, use the Letter Space button in the Edit panel to decrease the letter 
spacing until the individual letters overlap; then open the Actions panel and tap the Weld button.

Welding
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Slicing
Step 1 Position the layers or layer groups you would like to slice so that they overlap. Select both of 
them (see “Selecting” in the “Working with images” section of this manual for tips on selecting layers). 
Once two (and only two) layers are selected, the Slice button will become active in the Actions panel.
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Step 2 Tap “Slice” in the Actions panel to slice the two overlapping shapes into separate parts. You 
will know that your images are sliced when they change to the same color and appear as separate 
layers labeled “Sliced Image” in the Layers panel. You can then drag the sliced shapes apart to view 
them separately.

Tip: You may wish to ungroup layers of a layer group so that you can arrange them separately. The Slice 
tool will convert both selected layers into a single image (see “Grouping & ungrouping” in the “Actions 
panel” section of this manual). Once layers have been sliced, they can then be grouped with other layers 
without a�ecting the way the project cuts on the mat.
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Slicing
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Flattening & unflattening
The Flatten tool allows you to turn any image into a printable image for the Print then Cut feature of 
Cricut Design Space™. The Flatten tool not only turns your images into printable images, but also 
flattens them into a single layer. This means they will hold their size and position relative to each other 
when they are printed and cut. 

The Unflatten tool separates flattened layers. It also allows you to separate layers of an enhanced 
printable image if the image is multi-layered.

You can turn any standard image into a printable image by flattening it. You can also select multiple 
images (both standard and enhanced printable images) and flatten them together.

Tip: Print layers cannot be printed from the app. While projects with print layers can be designed in 
the app, you will need to use Design Space® on your PC or Mac® to complete the project.

Tip: Individual layers can be changed into printable images by changing their line type; however, they 
will each print separately (see “Changing line type” in the “Layers panel” section of the manual for 
more information). If you want to combine multiple layers into a single printable image, use the 
Flatten tool.

Flattening images & layers

Step 1 Tap the Image button to open the Insert Image panel. Choose any standard image from the 
Cricut® Image Library and insert it into your project.

Tip: You can also flatten images you have uploaded yourself using Design Space® for PC and Mac®. See 
the “Using your own images” section of the manual for Cricut Design Space™ for PC and Mac®.



Step 2 Tap the Actions button to open the Actions panel and the Layers button to open the 
Layers panel.

Step 3 Select one or more layers or layer groups you would like to flatten (see “Selecting” in the 
“Working with images” section of this manual for tips on selecting layers).

Step 4 Tap the Flatten button in the Actions panel to flatten layers for printing. You will know the 
layers have been flattened because they appear as a single layer in the Layers panel with the label 
“Flattened Set.” A printer icon also appears next to the layer thumbnail, indicating the layer will 
print then cut.

Tip: The line type of the image you wish to flatten must be set to Cut. See “Changing line type” in 
the “Layers panel” section of the manual for more information.
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Flattening & unflattening
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Unflattening standard images
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Flattening & unflattening

When you’ve flattened standard images, you can separate them into individual layers by 
unflattening them. 

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open 
the Layers panel.

Step 2 Select the flattened image you would like to unflatten.



Unflattening multi-layer enhanced printable images
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Section 11E
Actions Panel 

Flattening & unflattening
Step 3 Tap the Unflatten button in the Layers panel to separate the flattened image into 
individual layers.

Tip: The line type of unflattened layers will be set to print. See “Changing line type” in the “Layers 
panel” section of the manual to find out how to change to a cut, draw, or score layer.

Some of the images in the Cricut® Image Library are enhanced printable images especially prepared 
for the Print then Cut feature of Cricut Design Space™ for PC and Mac®. These images come onto the 
design canvas already flattened. An enhanced printable image may have multiple layers that are not 
visible while the image is in its flattened state. You can separate these multi-layered enhanced 
printable images into individual layers by unflattening them



Section 11E Page 5

Section 11E
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Flattening & unflattening
Step 1 Tap the Image button to open the Insert Image panel. Open the Filters menu and select 
“Multi-Layer”. Choose an enhanced printable image from the Cricut® Image Library (enhanced 
printable images are indicated by a printer icon in the top left corner of the image tile). Tap insert 
to add it to your project.

Step 2 Select the image. 
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Flattening & unflattening
Step 3 Tap the Unflatten button in the Actions panel to separate the flattened image into individual 
layers as seen in the Layers panel.

Tip: Some of the layers may have an icon in the Layers panel that depicts an eye with a line through it. 
These layers are hidden. See “Hiding & unhiding” in the “Layers panel” section of the manual for 
more information.



Arrange order of layer groups
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Arranging order

Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the Layers panel.

Step 2 Select a layer group by tapping on it on the design canvas or by tapping the layer group name in 
the Layers panel. 

Step 3 Tap the Arrange button to open the Arrange menu. Select one of the following options:

 • Move to Front: Moves the layer group to the front of the stack of layers on the design canvas and  
  the top of the Layers panel
 • Move Forward: Moves the layer group in front of the layer or layer group directly above it on the  
  design canvas and Layers panel
 • Move Backward: Moves the layer group behind the layer or layer group directly below it on the  
  design canvas and Layers panel
 • Move to Back: Moves the layer group to the back of the stack of layers on the design canvas and  
  the bottom of the Layers panel

The Arrange menu in the Actions panel allows you to change the stack order of the layers in your 
project. Layer groups or individual layers not part of a group can be arranged by moving them forward 
or backward in the stack of layers. All images and layers on the design screen have a stack order, even if 
they do not overlap visually, and you can view the stack order by tapping on the Layers button to open 
the Layers panel. The layer at the top of the Layers panel is the layer at the front of the layer stack on 
the design screen, while the layer at the bottom of the Layers panel is the layer at the back of the layer 
stack on the design canvas.



Arrange order of layers
Step 1 Tap the Actions button to open the Actions panel and the Layers button to open the Layers panel.

Step 2 Select an individual layer you would like to arrange (see “Selecting” in the “Working with 
images” section of this manual for tips on selecting layers). 

Tip: If the layer is part of a layer group, select the layer group and tap the Ungroup button in the 
Actions panel.
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Arranging order
In the image below, the “Move to Back” item in the Arrange menu was used to send the tulip to the 
bottom of the layer stack. Notice that the tulip has moved behind the torch image on the design canvas 
and below the torch image in the Layers panel. 



Step 3 Tap the Arrange button to open the Arrange menu. Select one of the following options:

 • Move to Front: Moves the layer to the front of the stack of layers on the design canvas and the  
  top of the Layers panel
 • Move Forward: Moves the layer group in front of the layer or layer group directly above it on the  
  design canvas and Layers panel
 • Move Backward: Moves the layer group behind the layer or layer group directly below it on the  
  design canvas and Layers panel
 • Move to Back: Moves the layer group to the back of the stack of layers on the design canvas and  
  the bottom of the Layers panel
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Arranging order



In the image below, the “Move Backward” item in the Arrange menu was used to send the blue torch 
layer one layer back in the layer stack. Notice that the blue layer has moved behind the brown torch 
image on the design canvas and below the brown torch image in the Layers panel.
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Arranging order
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Print then Cut
Bring a world of color to your project with the Print then Cut feature. Print your images on your home 
printer and then watch your Cricut Explore® cut them out with high precision—no scissors required!
There are two types of images you can print then cut: standard images and enhanced printable images.

Standard images are designed with solid colors. If a standard image has multiple layers, the di�erent 
layers of the image are shown individually in the Layers panel. These layers can be flattened into a 
single printable image by opening the Actions panel and then tapping the Flatten butoon. 

Enhanced printable images are designed with decorative patterns. An enhanced printable image 
appears as a single layer in the Layers panel. A printer icon appears next to the layer thumbnail, 
indicating the layer will print then cut.

Print layers cannot be printed from the Cricut Design Space™ app for iPad®. While projects with print 
layers can be designed in the app, you will need to use Cricut Design Space on your PC or Mac® to 
complete the project.

Tip: Individual layers can be changed into printable images by changing their line type; however, they 
will each print separately (see “Changing line type” in the “Layers panel” section of this manual for 
more information). If you want to combine multiple layers into a single printable image, use the Flatten
 tool (see “Flattening & unflattening” in the “Actions panel” section of this manual for more information).

If you choose to design a project containing a printable layer, you can save your project and complete it 
using the Print then Cut feature by opening the project with Design Space® for PC and Mac®. For more 
informatin, see the “Print then Cut” section of the Design Space® manual for PC and Mac®.
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Sending to mat
In order to complete your project, you’ll need to send it to the mat. When you tap the Send to Mat button,
you’ll be taken to the mat preview, where you can see how your project is laid out on the 
cutting mats. Once you’ve specified how many projects you want to make, selected a material size, and 
chosen whether to mirror your project, you’ll tap “Go” to begin cutting.

Tip: While you’re designing, you can send your project to the mat at any time to see how your project 
will be laid out on the cutting mats. Cutting will not begin until you tap “Go.”

 Tip: Sending to mat does not save changes to your project. If you wish to save your project, you can do 
so by tapping the Save button in the Design tab.
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Tip:  You can also access the mat preview by tapping the Mat tab. The mat preview screen shows the last 
project you sent to the mat.

Sending to mat
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The mat preview allows you to make changes to how your project will be cut. Note that while line 
type is indicated by a line type icon next to each mat thumbnail, the line type can only be changed in 
the Design tab. When you have finished making changes, tap the Go button to send the project to your 
machine so it can begin cutting.

Mat preview o�ers the following options:

 • editing mat order,
 • changing the number of project copies,
 • selecting material size,
 • mirroring all the images on a mat,
 • previewing each mat,
 • changing the position of images on the mat, and
 • skipping a mat.

When you tap “Edit,” you can change the order in which the mats will be cut.
 
Step 1 Tap “Edit” in the mat preview.

Mat preview
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Editing mat order
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If you’d like to cut more than one copy of your project, tap the Project Copies field and enter the 
number of copies you’d like to cut.

Mat preview

Section 13B
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Changing the number of project copies

Step 2 Tap and hold a mat handle, then drag the mat to change the order and release the mat handle. 
Repeat until mats are in the desired order.



The default material size for each mat is 12" x 12", but you can select a material size for each 
individual mat.
 
Step 1 In the mat preview, tap on a mat to select it.

Step 2 Tap “Material Size” to open the Material Size menu.

Selecting material size
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Tip: The Material Size menu only o�ers material sizes larger than the largest image on the mat.

Mat preview
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Step 3 Select a material size. The menu will close.
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You can turn mirroring on or o� by tapping the Mirror button. All the images on the mat will be 
mirrored. This is particularly important if you are using iron-on as your material; if you do not mirror 
the image, it will appear in reverse when ironed on.

Tip: Mirroring only a�ects the selected mat. If you wish to mirror more than one mat, turn mirroring 
on for each mat individually.

Mat preview
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Mirroring all the images on a mat
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All the mats are shown with a mat thumbnail on the left side of the mat preview. Scroll the mat list to 
view mats not visible on the screen.

When selected, a preview image of the mat is shown. You can change which mat is previewed by 
tapping on the mat in the mat list or by tapping the arrows on either side of the preview image.

Mat preview

Section 13B
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Previewing each mat
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Unless images have been attached using the Attach tool in the Actions panel, the project will cut in 
paper saver mode. Paper saver mode automatically places shapes on the cutting mat as close together 
as possible to conserve material. If you would like to change the position of one or more shapes on the 
mat, select the shape by tapping it on the preview image, and then drag it to the desired position. You 
can also rotate the shape using the rotate handle in the upper right corner of the bounding box.

Mat preview
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Changing the position of images on the mat
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Mat preview
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If you do not wish to cut one of the mats in your project, tap the Skip Mat button. You will know the 
mat will be skipped because it will show with a red X next to it in the mat list.

Tip: You can also skip mats during the cutting process. Tap the Skip Mat button while the machine is 
waiting for you to load that mat. The mat will be skipped and the machine will move on to the next mat.

Skipping a mat
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Step 1 When you’ve finished designing your project, tap the Send to Mat button.

Step 2 Make your selections in the mat preview (see “Mat preview” in the “Completing projects” 
section of the manual for more information) and tap the Go button.

Step 1 Place your material on the cutting mat in the top left corner inside the grid. 

Load, Set, Go
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Load
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Step 2 Position the mat under the mat guides. 

Step 3 Keeping the mat pressed firmly against the rollers, press the flashing Load/Unload button on 
the machine.

Load, Set, Go
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Step 4 If you will be writing or scoring on the mat, you will be prompted to insert the pen or scoring 
stylus in the accessory clamp. To do so, open accessory clamp A. Hold the clamp up while pushing the 
pen or scoring stylus down into the housing until the arrow on the pen or scoring stylus disappears. 
Close the clamp.

Tip: If you have more than one pen color or have drawing and scoring lines in your project, you will be 
prompted to change to the scoring stylus or appropriate pen.

Load, Set, Go
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Step 1 Select the appropriate material by turning the Smart Set® dial on the machine. If the material 
is not listed on the dial, set the dial to Custom.

Step 2 If the dial is set to Custom, open the materials menu and select a custom material.

Load, Set, Go
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Step 1 Press the flashing Go button on the machine.

Step 2 If your project has more than one mat, you will be prompted to load the next mat once the 
machine has finished cutting. 

Load, Set, Go
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Go
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Step 3 Unload the mat by pressing the Load/Unload button on the machine.

Step 4 Repeat the Load, Set, Go process for each mat in the project.

Tip: If you wish to skip a mat during the cutting process, tap the Skip Mat button while the machine is 
waiting for you to load that mat. The mat will be skipped and the machine will move on to the next mat.

Tip: If for some reason you need to interrupt the cut, press the pause button on the machine. You can 
start it back up where it left o� by pressing the pause button again, or you can unload the mat. If you 
unload the mat, the mat will start over unless you tap “Skip Mat” or one of the arrows on the sides of 
the preview image.

Load, Set, Go
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About image purchasing
Find and purchase single images and digital cartridges in the Cricut Design Space™ app for iPad®. 
You can design without purchasing an image; however, you must purchase the images in your project 
prior to cutting.
 
When you make a purchase with the app, you’ll use your Apple ID and password just as in any other 
in-app purchases you make with your iPad®. Image prices are set according to Apple® guidelines and 
may be di�erent from the prices listed in Design Space® on your PC or Mac®.
 
No matter where you’ve purchased images—whether by linking a Cricut® cartridge to your Cricut ID, 
purchasing through Cricut.com, or buying with Design Space® on your computer or iPad®—your 
purchased images are linked to your Cricut ID. These images are available in Design Space® whether 
you log in on your PC, Mac®, or iPad®.
 
For information about linking cartridges to your Cricut ID, see the “Cartridge linking” section of the 
Cricut Explore® machine manual.
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Single images are available for purchase in the Cricut Design Space™ app for iPad® when you send to 
your project to the mat and tap “Go.” When you make a purchase with the app, you’ll use your Apple ID 
and password just as in any other in-app purchases you make with your iPad®. Image prices are set 
according to Apple® guidelines and may be di�erent from the prices listed in Design Space® on 
your PC or Mac®.

If you wish to purchase individual images prior to cutting, or if you have a promotion code or discount, 
you can complete your purchase on Cricut.com or in Design Space® for PC and Mac®.
 
No matter where you’ve purchased images—whether by linking a Cricut® cartridge to your Cricut ID, 
purchasing through Cricut.com, or buying with Design Space® on your PC or Mac®—your 
purchased images are linked to your Cricut ID. These images are available in Cricut Design Space™ 
whether you log in on your PC, Mac®, or iPad®.
 
For details, see “Single images” in the “Purchasing images” section of manual for Cricut Design Space™ 
for PC and Mac®. 

Single images
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Digital cartridges are image sets you can use in Cricut Design Space™. If you wish to purchase digital 
cartridges (image sets), or if you have a promotion code or discount, you can complete your purchase 
on Cricut.com or in Design Space® for PC and Mac®. 

No matter where you’ve purchased images—whether by linking a Cricut® cartridge to your Cricut ID, 
purchasing through Cricut.com, or buying with Design Space® on your PC or Mac®—your purchased 
images are linked to your Cricut ID. These images are available in Design Space® whether you log in on 
your PC, Mac®, or iPad®.
 
For details, see “Digital cartridges” in the “Purchasing images” section of manual for Cricut Design 
Space™ for PC and Mac®. 
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Digital cartridges
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Physical cartridges
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Tip:  Digital cartridges you’ve purchased are automatically linked to your Cricut ID and are available 
in Cricut Design Space™ on your PC, Mac®, or iPad®.

Cricut Explore® machines are compatible with Cricut® cartridges. To use cartridges with your machine, 
you’ll need to link them to your Cricut ID.

If you’ve purchased physical cartridges and wish to use them with your Cricut Explore® machine, you 
need to link them to your Cricut ID. If you have already linked your cartridges to the Cricut Craft 
Room® design software, or linked your cartridges to your Cricut Gypsy™ device and then linked your 
Gypsy to your Cricut.com account, you have permanent digital access to those images.
 
If you’ve not yet linked your cartridges to your Cricut ID, you can link them using the port on your 
Cricut Explore® machine and Design Space® for PC and Mac®. Once they’ve been linked to your Cricut 
ID, they are available on the iPad® app as well as your computer.

To find out how to link Cricut® cartridges to your Cricut ID, see the “Cartridge Linking” section of the 
Cricut Explore® machine user manual.

Once your cartridges are linked to your Cricut ID, you have full access to them in Design Space® on your 
computer or iPad®. For more information on finding cartridges you’ve linked to your Cricut ID, see 
“Searching with categories & filters” in the “Image library” section of this manuel.

Linking physical cartridges

Using linked cartridges in Cricut Design Space™



Subscription to the Cricut® Image Library gives you unlimited access to over 25,000 images, projects, 
and fonts. If you wish to purchase a subscription, or if you have a promotion code or discount, you can 
complete your purchase on Cricut.com or in Cricut Design Space™ for PC and Mac®.
 
No matter where you’ve purchased your subscription—whether through Cricut.com or Design Space® 
on your PC or Mac®—your subscription is linked to your Cricut ID. The images that make up a Cricut® 
Image Library subscription are available in Design Space® whether you log in on your PC, Mac®, or iPad®.
 
For details, see “Subscription” in the “Purchasing images” section of manual for Cricut Design Space™ 
for PC and Mac®. 
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Subscription
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